
Design Guide: TIDA-010250
1kW BLDC 电机逆变器参考设计

说明

该参考设计展示了采用 Arm® Cortex®-M0+ 内核微控制

器 MSPM0G1507 的电机逆变器。该设计不仅支持使

用 1 至 3 个分流电阻器的无传感器磁场定向控制 

(FOC) 算法，还支持采用霍尔效应传感器或正交编码

器接口 (QEI) 传感器的有传感器电机驱动算法。该参考

设计提供的硬件和软件已经过测试，而且可随时使用，
有助于加快开发，从而缩短产品上市时间。

资源
TIDA-010250 设计文件夹

MSPM0G1507 产品文件夹

UCC28881 产品文件夹

UCC27712 产品文件夹

TLV9064 产品文件夹

TPS54202 产品文件夹

ISO6721 产品文件夹

请咨询我司 TI E2E™ 支持专家

特性

• 使用 1 个、2 个或 3 个分流电阻器实现无传感器 

FOC 算法电机控制

• 使用霍尔效应或 QEI 实现有传感器电机控制

• 功率高达 1kW 的逆变器级

• 具有过流和过压保护功能的稳健设计

应用

• 冰箱和冷冻柜
• 洗衣机和烘干机
• 搅拌器、搅拌机和食品加工机
• 油烟机
• 空调室内机
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1 系统说明

当今大型家电应用所采用的电机控制技术必须满足日益增长的对于更低成本、更小尺寸、更高功率和更高能效的
需求。无刷直流 (BLDC) 电机和永磁同步电机 (PMSM) 在大型家电应用中越来越常用。借助高速 Arm Cortex-M0+ 
内核和丰富的模拟外设，MSPM0G1507 微控制器可为有传感器或无传感器电机控制提供真正的单芯片解决方案，
从而帮助设计人员减少物料清单中的元件数量，并设计出具有成本效益的紧凑型电机逆变器。

1.1 主要系统规格

参数 测试条件 最小值 标称值 最大值 单位

输入电压 165 230 265 VAC

输入频率 47 50 63 Hz

PWM 开关频率 (ƒSW) 8 kHz

额定功率输出 (POUT) 1 kW

输出电流 (IRMS) 3 A

逆变器效率 97 %

电机电气频率 30 100 200 Hz

故障保护 过流、过压、过热、欠压

驱动控制方法 使用霍尔效应或 QEI 实现有传感器电机控制；使用 1 个、2 个或 3 个分流电阻器实现无传感器电机

控制

工作环境温度 开放式框架 -10 25 55 °C

内置辅助电源 VINAC = 最小值至最大值 15V ±10%，200mA

电路板尺寸 140mm × 140mm × 40mm

警告

TI 建议，该参考设计仅可在实验室环境中运行，不应将此参考设计作为成品供一般消费者使用。

TI 建议，该参考设计仅可由熟悉处理高压电子和机械部件、系统及子系统所存在相关风险的合格工程

师和技术人员使用。

高电压！电路板中存在可接触到的高电压。如电路板的电压和电流处理不当或施加不正确，则可能导

致电击、火灾或伤害事故。使用该设备时应特别小心，并采取相应的保护措施，以避免伤害自己或损

坏财产。

表面高温！接触会导致烫伤。请勿触摸！电路板上电后，某些元件可能会达到 55°C 以上的高温。由

于存在高温，在使用过程中或使用刚结束时，用户不得触摸电路板。

小心

请勿在无人照看的情况下使该设计通电。
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2 系统概述

2.1 方框图

图 2-1 展示了参考设计方框图。

整个系统包含以下几块：

• 辅助电源
• MCU 控制器

• 三相逆变器
• 使用分流电阻器进行相电流检测
• 霍尔效应或 QEI 接口

• 隔离式通用同步或异步接收器或发送器 (USART) 串行通信
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图 2-1. 参考设计的方框图
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2.2 设计注意事项

该系统从一个二极管电桥开始，这个电桥具有电解电容器，可以创建稳定的直流总线。基于 UCC28881 的简单高

压降压电源可为栅极驱动器 UCC27712 提供非隔离式 15V 电压来驱动绝缘栅双极晶体管 (IGBT)。

TPS54202 直流/直流控制器可将 15V 降压至 5V，而 TLV74033 可提供低纹波 3.3V 电压为微控制器供电，并用作

模数转换器 (ADC) 的电压基准。

MSPM0G1507 微控制器为 IGBT 的栅极驱动器提供六个 PWM 来控制流向电机的电流，该器件还会检测直流总线

电压、环境温度、霍尔效应或 QEI 信号以及相电流，从而实现电机控制算法。

2.3 主要产品

本参考设计采用了以下重点产品。以下各节介绍选择用于该参考设计的器件时应考虑的主要特性。如需了解有关
重点器件的更多详细信息，请参阅各自的产品数据表。

2.3.1 MSPM0G1507

MSPM0G1507 微控制器 (MCU) 属于高度集成的超低功耗 32 位混合信号处理 (MSP) MCU 系列，该系列基于增

强型 Arm® Cortex®-M0+ 32 位内核平台，工作频率高达 80MHz。这些低成本 MCU 提供高性能模拟外设集成，
支持 -40°C 至 125°C 的工作温度范围，并在 1.62V 至 3.6V 的电源电压下运行。MSPM0G1507 器件提供具有内

置纠错码 (ECC) 且高达 128KB 的嵌入式闪存程序存储器以及具有硬件奇偶校验选项且高达 32KB 的 SRAM。此

类器件还包含一个存储器保护单元、7 通道 DMA、数学加速器和各种高性能模拟外设，例如两个 12 位 4MSPS 
ADC、一个可配置内部共享电压基准、一个 12 位 1MSPS DAC、三个具有内置基准数模转换器 (DAC) 的高速比

较器、两个具有可编程增益的零漂移零交叉运算放大器和一个通用放大器。此外，还提供智能数字外设，例如三

个 16 位高级控制计时器、三个 16 位通用计时器、一个 24 位高分辨率计时器、两个窗口式看门狗计时器以及一

个具有警报和日历模式的 RTC。这类器件可提供数据完整性和加密外设以及增强型通信接口（四个 UART、两个 

I2C、两个串行外设接口 (SPI)）。

2.3.2 UCC28881

UCC28881 在单片器件中集成了控制器和 14Ω、700V 功率 MOSFET。该器件还集成了高压电流源，能够在经整

流的市电电压下直接启动和运行。UCC28881 与 UCC28880 属于同一系列的器件，但电流更高。

该器件的静态电流较低，能够提供出色的效率。凭借 UCC28881，使用很少的外部元件即可构建降压、降压/升压

以及反激拓扑等常用的转换器拓扑。

2.3.3 UCC27712

UCC27712 是一款 620V 高侧和低侧栅极驱动器，具有 1.8A 拉电流、2.8A 灌电流，专用于驱动功率 MOSFET 或 

IGBT。对于 IGBT，建议的 VDD 工作电压为 10V 至 20V，对于功率 MOSFET，建议的 VDD 工作电压为 10V 至 

17V。UCC27712 包含保护功能，在此情况下，当输入保持开路状态时，或当未满足最低输入脉宽规格时，输出

保持低位。互锁和死区时间功能可防止两个输出同时打开。

2.3.4 TLV9064

TLV9064 是具有轨至轨输入和输出摆幅功能的四路低压（1.8V 至 5.5V）运算放大器。这些器件是非常具有成本

效益的设计，适用于需要低电压运行、小型封装尺寸和高容性负载驱动能力的应用。虽然 TLV906x 的容性负载驱

动能力为 100pF，但电阻式开环输出阻抗便于在更高的容性负载下更轻松地实现稳定。TLV906xS 器件具有关断

模式，允许放大器切换至典型电流消耗低于 1µA 的待机模式。TLV906xS 系列有助于简化系统设计，因为该系列

具有稳定的单位增益，集成了 RFI 和 EMI 抑制滤波器，而且在过驱条件下不会出现反相。

2.3.5 TPS54202

TPS54202H 是一款输入电压范围为 4.5V 至 28V 的 2A 同步降压转换器。该器件包含两个集成式开关 FET，并且

具备内部环路补偿和 5ms 内部软启动功能，从而降低组件数。

高级 Eco-mode 实现可尽可能提高轻负载效率并降低功率损耗。

两个高侧 MOSFET 内的逐周期电流限制可在过载情况下保护转换器，并通过低侧 MOSFET 续流电流限制防止电

流失控，增强限制效果。
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3 系统设计原理

该参考设计的主要重点是搭载 MSPM0G1507 微控制器的电机控制系统，可以支持电器应用中的有传感器和无传

感器 FOC 算法。

3.1 高压降压辅助电源

基于 UCC28881 的简化高压降压电源为该参考设计提供辅助电源，可在 15VDC 下提供高达 200mA 的电流。

图 3-1 展示了 UCC28881 高压降压电源电路。
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图 3-1. UCC28881 高压降压电源电路
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3.2 直流总线电压检测

直流电压检测电路用于将整流后的电压信号转换为可由低成本电阻分压器网络检测到的低压信号，如图 3-2 所
示。直流总线电压也可用于估算交流输入电压。
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图 3-2. 直流总线检测电路

3.3 电机驱动级

三相电机逆变器通过一个六片式 10A IGBT 实现。图 3-3 展示了一个包含半桥 IGBT 和驱动器的电路。通过改变 

IGBT 栅极电阻器可以控制 IGBT 的上升或下降时间，从而在功率损耗和 EMI 噪声水平之间进行权衡。
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图 3-3. 半桥 IGBT 和栅极驱动器

3.4 旁路电容器

每个半桥都有一个高电压 (1kV) 陶瓷旁路电容器（原理图上的 C43、C48 和 C62），为每个半桥提供 0.1μF 的电

容，请参阅图 3-3。这些旁路电容器可以在开关期间处理每个半桥中的高频电流，这是电解直流大容量电容器无法

实现的。这些 X7R 电容器还有助于降低 EMI 噪声水平。
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3.5 使用两个或三个分流电阻器进行相电流检测

该参考设计支持 1 个、2 个或 3 个分流电阻器。该参考设计中使用一个外部 TLV9064 来检测三个相电流；但是，
MSPM0G1507 微控制器有两个内置的零漂移零交叉运算放大器。这些运算放大器最多支持两相电流采样，因此无

需外部运算放大器，从而降低了系统成本。图 3-4 展示了分流电阻器配置。
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图 3-4. 分流电阻器配置

3.6 使用单个分流电阻器进行相电流检测

该参考设计还支持使用内置运算放大器进行单相电流检测。图 3-4 中的 R72 是用于单相电流检测的分流电阻器，
R67、R68 和 R69 可针对此类应用进行端接。该参考设计选择内部运算放大器 OPA0 来支持单相电流检测。图 

3-5 展示了内部 OPA0 的电路，增益和带宽可由这些电阻器和电容器进行设置，默认增益为 2。
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图 3-5. 内部运算放大器 OPA0 的电路

3.7 使用霍尔效应传感器或 QEI 接口实现传感器式电机控制

该参考设计还支持基于霍尔效应或正交编码器接口 (QEI) 模式的有传感器电机控制算法。MSPM0G1507 有一个支

持 2 信号或 3 信号 QEI 的 TIMG 计时器。当配置为 QEI 模式时，TIMG 可以收集正交编码信号，来提供有关线性

或旋转运动的相对定位和移动的信息。

QEI 由两个灰度编码的正交输入信号 PHA 和 PHB 以及一个索引输入信号 IDX 组成。所有输入信号都进入单个计

数器的 CCP 输入，使 PHA 和 PHB 映射到 CCP0 和 CCP1，而 IDX 作为单独的输入引入。

对于以下情况，该参考设计支持 3.3V 或 5V 电平霍尔效应传感器：

• 使用 3.3V 霍尔效应传感器或 QEI 传感器

• 开启所有 Hall1V33、Hall2V33、Hall3V33
• 移除 R64、R65 和 R66
• 使用 5V 霍尔效应传感器或 QEI 传感器

• 关闭开关 S1 的所有 Hall1V33、Hall2V33、Hall3V33、QEI1GND、QEI2GND 和 QEI3GND
• 组装 R64、R65 和 R66

图 3-6 展示了霍尔效应和 QEI 接口电路
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3.3V

GND

SWCLK
SWDIO

RST1
2
3
4
5

J8

61300511121

QEI/Hall1

QEI/Hall2

QEI/Hall3

GND

4

1
2
3

J10

PBC04SAAN

5V_ISO

GND_ISO

UART0_RXO
UART0_TXO

GND

1
2
3
4
5

J9

61300511121 R55
2.10k

5V

GND

R56
2.10k

R57
2.10k

HALL：depop R64,R65,R66

QEI：depop R119,120,121

2TP4

5015

5015 TP43

5015
TP44

GND

3.3V

Hall1V33
Hall2V33

Hall3V33

QEI1GND
QEI2GND

QEI3GND

1
2
3

QEI3GND4
QEI2GND5
QEI1GND6

11
12

S1

1571983-9

Hall1V33
Hall2V33
Hall3V33

100nF

C47
25V

1nF
25V

C52

1nF
25V

C53

1nF

C54

25V

3.3k
R119 R120

3.3k
R121
3.3k

R64
3.9k

R65
3.9k

R66
3.9k

1
2
3

22284030

J11
GND

UART0_RX
UART0_TX

图 3-6. 霍尔效应和 QEI 接口电路

3.8 使用 DAC 进行软件调试

为了简化软件调试，该参考设计提供了两个 DAC 来导出指定的信号，例如旋转角度、简化的相电流、PWM 占空

比等。如图 3-7 所示，DAC 是一款独立的内部 12 位数模转换器。图 3-7 中的 DAC2 是间接 8 位数模转换器，必

须通过内部运算放大器 OPA0 进行缓冲。但是，如果 OPA0 用于相电流检测，则该运算放大器无法输出 DAC2。
图 3-7 展示了数模转换器电路。

DAC
OPA_OUT
OPA_IN-
OPA_IN+
SWDIO
SWCLK

UART0_RX_FREQ

PA13
29 PA14
30 PA15/A1_0
31 PA16/A1_1
32 PA17/A1_2
33 PA18/A1_3
34 PA19/SWDIO
35 PA20/SWCLK
39 PA21/A1_7/VREF-
40 PA22/A0_7
43 PA23/VREF+
44 PA24/A0_3
45 PA25/A0_2
46 PA26/A0_1
47 PA27/A0_0
3 PA28
5 PA31

NU_AD
NV_AD

Ubus_AD

Ta_AD

RELAY

5015 DAC2

5015
RELAY

DAC2
GND R48

1.00k

4.7nF
C44

50V

GND

4.7nF
C25

50V

R102

1.00k

图 3-7. 数模转换器

3.9 过流保护

该参考设计通过外部运算放大器和内部比较器实现过流保护 (OCP)。图 3-8 展示了外部运算放大器 OCP，该电路

汇总电流的三个相位，然后与基准电压 (0.2V) 进行比较以生成过流故障信号。另一个 OCP 是用于单分流电阻器

电流检测的内部比较器。内部运算放大器输出可直接连接到内部比较器来实现过流保护。设计的外部运算放大器 
OCP 触发点为 6A 峰值相电流，而内部比较器的 OCP 触发点可通过内部基准进行设置。
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14
12

13

D

U8D
TLV9064IPWR

GND

A3.3V

GND

GND

GND

IU
IV
IW

#FAULT

R101300
R103300

R109300

10nF
C67

50V

100pF
C59

50V

R112
1.80k

5015

FAULT

47nF
C65

50V
1nF
25V

C66

R110

1.00k
27.0k
R111

图 3-8. 外部过流保护电路

3.10 过热保护

设计中有一个 M3 螺钉安装孔可用于在散热器上连接热敏电阻以检测散热器温度。软件可以对该温度信号进行采

样以便在指定级别触发过热保护。

3.11 隔离式 UART 端口

该参考设计提供了一个隔离式 UART 端口与 J10 上的主机控制器进行通信。需要使用外部 5V 或 3.3V 电源轨为 

U10 隔离器的隔离侧供电。

3.12 逆变器峰值功率能力

该参考设计采用一个 10A IGBT，这个 IGBT 可在 125°C 结温下提供高达 6ARMS 的连续电流。6ARMS 是 

TIDA-010250 设计的间歇性最大电流额定值。逆变器的连续电流能力 (≤ 6ARMS) 由热设计决定。假设三相输出电

压 (VOUT) 为 200VRMS 并使用单位功率因数 (PF)，GaN 逆变器的峰值功率能力 (PPEAK) 可由方程式 1 计算得出：PPEAK = 3 × VOUT × IOUT × PF = 3 × 200 × 6 × 1 = 2078 W (1)

PPEAK 是 GaN 逆变器能够处理的绝对最大功率，该逆变器的连续功率额定值由热设计、峰值环境温度和过流保护

设置决定。
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4 硬件、软件、测试要求和测试结果

4.1 硬件要求

本节详细介绍了设计电路板和软件测试和检验所需的设备、测试装置和过程说明。

4.1.1 硬件板概述

图 4-1 展示了该参考设计的系统方框图。

AC Mains
AC Rectifier

EMI Filter

3-phase 

Inverter Stage

Control
Bias Power 

Supply

Motor

图 4-1. TIDA-010250 系统方框图

电机控制板具有可实现完整电机驱动系统的功能组。下面列出了这个板上的各个块以及这些块的功能。图 4-2 展
示了这个板的顶视图和 TIDA-010250 PCB 的不同块。

• 交流输入连接器和滤波器
• 辅助电源
• MCU 控制器

• 电机逆变器输出连接器
• 使用分流电阻器进行相电流检测
• 霍尔效应或 QEI 接口

• USART 串行通信

图 4-2. M0 电机逆变器板的布局
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TI 建议在使用该板时采取以下预防措施：

• 电路板通电时，请勿触摸电路板的任何部分或连接到电路板的元件。

• 使用交流电源或墙上电源为套件供电。TI 建议使用隔离交流电源。

• 通电时请勿触摸电路板、套件或组合件的任何部分。尽管电源模块散热器与电路板隔离，但高电压开关会在散

热器上产生一些电容耦合电压。
• 控制接地可能很热。

4.1.2 用于电路板验证的测试设备

建议使用以下设备进行电路板验证：

• 隔离式交流源
• 单相功率分析仪
• 数字示波器
• 万用表
• 三相 PMSM 电机

• 测力计
• 电流高达 6A 的直流电流源

• 首选 15VDC 电源

• 三相功率分析仪
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4.2 软件要求

4.2.1 MSPM0 固件入门

通过 TI 提供的链接下载 MSPM0-SDK mspm0_sdk_2_01_00_03 或更高版本的软件，并进行安装。将该 

MSPM0 SDK 软件安装在默认文件夹中。然后，TIDA010250 软件工程将位于 MSPM0 SDK 文件夹 
<install_location>\ti\mspm0_sdk_2_01_00_03\examples\nortos\LP_MSPM0G3507\motor_con
trol_bldc_sensorless_foc\senslroess-foc_TIDA010250\

4.2.1.1 下载并安装电路板测试所需的软件

1. 通过 TI 提供的链接下载 MSPM0-SDK mspm0_sdk_2_01_00_03 或更高版本的软件，并进行安装。

2. 通过以下两种方式之一安装 MSPM0-SDK：
• 转至 CCS 的 Project → Import CCS Project 下，浏览并选择 senslroess-foc_TIDA010250 文件夹以

导入此工程。
• 转至 CCS 的 View → Resource Explorer 下。在 TI Resource Explorer 下，转至 Arm-based 

microcontroller → Embedded Software → MSPM0-SDK，然后点击 Download 和 Install。
3. 安装完成后，关闭 CCS 并创建一个新的工作区以导入工程。

4.2.1.2 将工程导入 CCS

打开 CCS 并选择 Project → Import CCS Project，浏览到 MSPM0 SDK 中的以下文件夹：

<install_location>\ti\mspm0_sdk_2_01_00_03\examples\nortos\LP_MSPM0G3507\motor_con

trol_bldc_sensorless_foc\sensorless-foc_TIDA010250，图 4-3 显示了该文件夹。

图 4-3. sensorless-foc_TIDA010250 文件夹
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图 4-4 显示了该文件夹中找到的工程。选择该工程并点击 Finish 按钮以导入该工程。

图 4-4. 该文件夹中的工程

4.2.1.3 编译工程

TIDA-010250 的 Sensorless-foc 工程现在处于活动状态。点击 Build 按钮或选择 Project → Build Project 菜
单，编译完成后将生成 .out 文件。图 4-5 展示了生成的工程构建结果。

图 4-5. 构建工程

现在打开 ISR.c 文件以检查电机参数，请参阅无传感器 FOC 电机控制用户指南 中的寄存器映射部分，该指南位

于 MSPM0 SDK 文件夹：

<install_location>\ti\mspm0_sdk_2_01_00_03\docs\english\middleware\motor_control_b
ldc_sensorless_foc
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图 4-6 显示了文件位置。

图 4-6. 无传感器 FOC 电机控制用户指南所在的文件夹

此设计指南介绍了 FOC 算法的所有寄存器，设计人员还可以使用这些寄存器添加或删除 FOC 的一些特殊功能。

图 4-7 显示了寄存器映射。

图 4-7. 寄存器映射

硬件、软件、测试要求和测试结果 www.ti.com.cn

14 1kW BLDC 电机逆变器参考设计 ZHCUB27B – MAY 2023 – REVISED SEPTEMBER 2024
提交文档反馈

English Document: TIDUF31
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUB27
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUB27B&partnum=TIDA-010250
https://www.ti.com/lit/pdf/TIDUF31


电机和控制参数位于 ISR.c 中，可根据用户的电机和系统进行更新。电机 EMJ_04APB22 的参数以及每个参数

的单位如下所示。有关更多信息，请参阅 MSPM0 无传感器 FOC 调优指南 应用手册。

pUserInputRegs->systemParams.mtrResist = 2627; // Rs(mR)
pUserInputRegs->systemParams.mtrInductance = 8608; // Ls(uH)
pUserInputRegs->systemParams.mtrBemfConst = 3779; // 10*BEMP, BEMF(mVpHz)
pUserInputRegs->systemParams.voltageBase = 258.6; // Vbase(V)/sqrt(3)
pUserInputRegs->systemParams.currentBase = 8.25; // Ibase(A)
pUserInputRegs->systemParams.maxMotorSpeed = 200; // Maximum Speed(Hz)
pUserInputRegs->systemParams.speedLoopKp = 0.0539; // Speed Loop Kp
pUserInputRegs->systemParams.speedLoopKi = 0.036; // Speed Loop Ki
pUserInputRegs->systemParams.currLoopKp = 3.42; // Current Loop Kp
pUserInputRegs->systemParams.currLoopKi = 3678; // Current Loop Ki

更新电机和控制参数后，点击 Compile 按钮，没有错误信息，在 Console 窗口中会创建 .out 文件，请参阅图 

4-8。

图 4-8. EMJ_04APB22 电机参数和编译结果
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4.2.1.4 下载映像并旋转电机

点击 Run → Debug 菜单选项，下载软件并在 CCS 中调试，然后将 pUserCtrlRegs 变量添加到 Expressions 
窗口中，选择 pUserCtrlRegs → speedCtrl → b → speedInput，右键点击，选择 Q-Values → Q-Value(15)。图 

4-9 显示了在何处以及如何更改值类型。

图 4-9. 下载和调试

通过点击 CCS 中的 Run 按钮来运行代码，并将 speedInput 更改为非零值以使电机旋转，例如更改为 0.6，此

数字是最大速度的标准化编号，因此如果 speedInput = 1，电机将以最大速度运行。要停止电机，请将 

speedInput 设置为 0。

图 4-10 显示了在何处更改 speedInput 值。

图 4-10. 通过 speedInput 设置电机速度百分比
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4.3 测试结果

以下各节显示了测试数据。测试结果分为多个部分，涵盖 PMSM 电机的稳态性能和数据、功能性能波形以及瞬态

性能波形。

4.3.1 测试设置

图 4-2 显示了这些块和连接器在板上的位置。按照以下步骤来设置测试。

1. 将串行线调试 (SWD) 仿真器连接至连接器 J8 以对 MSPM01507 进行调试或编程。将主机 PC 与 

TIDA-010250 板隔离。

2. 将电机电缆连接到端子 J4、J5 和 J6。
3. 通过将电源连接到 J1、J2 和 J3，为逆变器提供直流总线电源、交流电源或交流主电源。

• 直流电源的最大输出为 380VDC。

• 交流电源的最大输出为 265VAC（频率为 50/60Hz）。

• 交流市电为 220VAC（频率为 50/60Hz）。
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4.3.2 辅助电源测试

图 4-11 展示了负载为 200mA 且输出为 15VDC 时的降压电源波形。

• CH1（蓝色）：15V 电压轨

• CH3（紫色）：UCC28881 引脚 1 处的开关节点

• CH4（绿色）：15V 输出电流

图 4-12 展示了 15V、100mA、25°C 环境温度条件下的降压电感器温度。

图 4-11. 220VAC、200mA 时的

UCC28881 波形
图 4-12. 220VAC、100mA 时降压电源的电感器温升

4.3.3 电流开环测试

该测试显示了在开环模式下产生正弦相电流的软件行为，图 4-13 展示了波形。

• CH2（青色）：交流输入电压

• 通道 3（紫色）：直流总线电压

• CH4（绿色）：U 相电流

图 4-13. 开环模式下的相电流
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4.3.4 过流保护测试

可以使用外部 15VDC 电源完成该测试。请按照以下步骤来执行该测试：

1. 使用直流插孔 J7 的外部 15VDC 电源为电路板供电。

2. 将直流电源连接到分流电阻器 R67 的两个端子。

3. 将直流电源设置为恒压模式和最大电流。

4. 启用输出，然后浪涌输出电流流经 R67。
5. 调整电源电压和电流输出。

6. 确保浪涌电流足够高 (> 6.5ADC) 以触发 OCP。

图 4-14 展示了电流超过 6A 时故障信号会下降。下降时间小于 2μs，速度可以足够快，能够保护大多数 IGBT。

• CH1（蓝色）：#FAULT 测试点的故障信号

• CH4（绿色）：R67 上的电流

图 4-14. 过流保护响应时间
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4.3.5 电机启动序列

图 4-15 展示了采用无传感器 FOC 算法的 PMSM 电机的启动序列波形。该序列通常包含三个阶段：对齐、开环斜

升、速度闭环。在对齐过程中完成以下步骤：

1. 缓慢增大对齐电流以防止出现浪涌电流

2. 移至开环斜升

3. 可设置斜升电流以满足启动负载要求

4. 转子位置观测器在斜升时间内开始工作

5. 一旦电机速度达到设定点并且转子角度误差足够小，软件就会进入闭合速度和闭合电流环路

图 4-15 展示了下列通道。

• CH1（蓝色）：观察到的转子角度

• CH2（青色）：交流输入电压

• 通道 3（紫色）：直流总线电压

• CH4（绿色）：U 相电流

图 4-15. 采用无传感 FOC 算法的 PMSM 电机启动序列
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4.3.6 负载测试

该参考设计执行了负载测试以验证整体热设计。图 4-16 展示了 460W 负载下的电路板温升情况。散热器温度仅为 

32°C。保险丝和二极管电桥是最热的位置，但仍有足够的裕度，可以拆下保险丝盖来进行冷却。

图 4-16. 460W 负载下的

电路板温升

图 4-17. 460W 负载下的测试波形

图 4-17 展示了在 460W 负载下使用以下通道分配方案时的测试波形：

• CH1（蓝色）：观察到的转子角度

• CH2（青色）：交流输入电压

• 通道 3（紫色）：直流总线电压

• CH4（绿色）：U 相电流

图 4-18 展示了采用测力计的负载测试设置。

图 4-18. 负载测试设置
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4.4 将固件迁移至新的硬件板

4.4.1 配置 PWM、CMPSS 和 ADC 模块

SYSCFG_DL_init() 具有初始化函数。在 main.c 中找到 SYSCFG_DL_init()，按 CTRL 键并点击函数，
SYSCFG_DL_init() 将打开，在 SYSCFG_DL_init() 中可以找到用于配置 GPIO、ADC、PWM 等的函数。图 

4-19 显示了这些函数。

图 4-19. 用于初始化的 GPIO、ADC 和 PWM 函数

在 Debug → syscfg → ti_msp_dl_config.h 中，可以找到所有 GPIO、PWM 和 ADC 的定义并针对新硬件板进行

更新。图 4-20 显示了这些定义。

图 4-20. GPIO、ADC 和 PWM 定义
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4.4.2 电机和控制参数调优

如需详细了解电机和控制参数调优，请参阅 MSPM0 无传感器 FOC 调优指南 应用手册。
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5 设计和文档支持

5.1 设计文件

5.1.1 原理图

要下载原理图，请参阅 TIDA-010250 中的设计文件。

5.1.2 材料清单

要下载物料清单 (BOM)，请参阅 TIDA-010250 中的设计文件。

5.2 工具

工具

Code 
Composer 
Studio™ 

Code Composer Studio® (CCS) 是适用于 TI 微控制器和处理器的集成开发环境 (IDE)。CCS 包
含一整套用于开发和调试嵌入式应用的工具。Code Composer Studio 可在 Microsoft® 

Windows®、Linux® 和 macOS® 桌面平台上进行下载。此外，可以通过访问 TI 开发人员专区，
在云中使用 CCS。

MSPM0-SDK MSPM0 SDK 通过单个软件包提供软件、工具和文档的精选集合，可以加快 MSPM0 MCU 平台

应用程序的开发。

5.3 文档支持

1. 德州仪器 (TI)，MSPM0G150x 混合信号控制器数据表
2. 德州仪器 (TI)，“UCC28881 700V、225mA 低静态电流离线转换器”数据表
3. 德州仪器 (TI)，“UCC27712 具有互锁功能的 620V、1.8A、2.8A 高侧低侧栅极驱动器”数据表
4. 德州仪器 (TI)，“TLV906xS 适用于成本敏感型系统的 10MHz、RRIO、CMOS 运算放大器”数据表
5. 德州仪器 (TI)，“TPS54202 4.5V 至 28V 输入、2A 输出、EMI 友好型同步降压转换器”数据表
6. 德州仪器 (TI)，“ISO672x EMC 性能优异的通用基础型双通道数字隔离器”数据表

5.4 支持资源

TI E2E™ 中文支持论坛是工程师的重要参考资料，可直接从专家处获得快速、经过验证的解答和设计帮助。搜索

现有解答或提出自己的问题，获得所需的快速设计帮助。

链接的内容由各个贡献者“按原样”提供。这些内容并不构成 TI 技术规范，并且不一定反映 TI 的观点；请参阅 

TI 的使用条款。

5.5 商标
TI E2E™ is a trademark of Texas Instruments.
Arm® and Cortex® are registered trademarks of Arm Limited.
Code Composer Studio®, Microsoft®, and Windows® are registered trademarks of Microsoft Corporation.
macOS® is a registered trademark of Apple Inc.
所有商标均为其各自所有者的财产。
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重要声明和免责声明
TI“按原样”提供技术和可靠性数据（包括数据表）、设计资源（包括参考设计）、应用或其他设计建议、网络工具、安全信息和其他资源，
不保证没有瑕疵且不做出任何明示或暗示的担保，包括但不限于对适销性、某特定用途方面的适用性或不侵犯任何第三方知识产权的暗示担
保。
这些资源可供使用 TI 产品进行设计的熟练开发人员使用。您将自行承担以下全部责任：(1) 针对您的应用选择合适的 TI 产品，(2) 设计、验
证并测试您的应用，(3) 确保您的应用满足相应标准以及任何其他功能安全、信息安全、监管或其他要求。
这些资源如有变更，恕不另行通知。TI 授权您仅可将这些资源用于研发本资源所述的 TI 产品的应用。严禁对这些资源进行其他复制或展示。
您无权使用任何其他 TI 知识产权或任何第三方知识产权。您应全额赔偿因在这些资源的使用中对 TI 及其代表造成的任何索赔、损害、成
本、损失和债务，TI 对此概不负责。
TI 提供的产品受 TI 的销售条款或 ti.com 上其他适用条款/TI 产品随附的其他适用条款的约束。TI 提供这些资源并不会扩展或以其他方式更改 
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